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Foreword

Welcome
Thank you for using KONICA MINOLTA PageScope Network Setup.

PageScope Network Setup is utility software which allows simple
network setup of devices such as printers. It allows setup of devices on
networks connected using TCP/IP or IPX protocol to be handled
together.

PageScope Network Setup supports the following functions.

* Displays a list of devices on the network.

Allows a user to verify and change the network and print settings for
devices.

* Accesses the Web settings page in the device.

Allows monitoring of the device status.

* Displays alert and output tray information for a device.
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1 System Requirements

1 System Requirements

The following are the minimum system requirements for installing
PageScope Network Setup.

0S*(1) - Windows 95/98/Me
- Windows NT 4.0
- Windows 2000
- Windows XP
Browser - Internet Explorer 4.0 or later
NetWare Client*(2) - Novell NetWare Client 32 (latest version)
Protocol*(3) - TCP/IP
- IPX/SPX

*(1) We recommend you to use the latest version service packs when using
Windows NT 4.0 or Windows 2000.

*(2) Although this utility can work without NetWare, it is required when you
set up NetWare.

*(3) The tools provided by this utility differ according to the type of protocol
supported on the user network environment.




2 Installing and Starting PageScope Network Setup

2 Installing and Starting PageScope
Network Setup

2.1 Installing PageScope Network Setup

Use the following procedure to install PageScope Network Setup.

1. Place the CD-ROM into your computer’s CD-ROM drive.

2. Start up the installation program. (setup.exe)

3. Follow the instructions that appear on your computer screen to
proceed with the installation.

The following is the default installation location used by the
installer.

C:\Program Files\KONICA MINOLTA\PageScope
Network Setup

The installer provides you with an opportunity to specify a
different location, if you want.

2.2 Starting PageScope Network Setup

1. Click Start - Programs — KONICA MINOLTA — PageScope
Network Setup — PageScope Network Setup.
In the case of Windows XP, click start — All Programs —
KONICA MINOLTA — PageScope Network Setup —
PageScope Network Setup.

2. When the Login Password dialog box appears, type in the
password.

Note

* The default password is “admin”.

* For details on changing the password, refer to “5.5 Changing the
Password”.

*  When you start up PageScope Network Setup, it searches for devices
on the network. The search procedure can take anywhere from a few
seconds to 20 or 30 seconds or more. Wait for the search procedure to
complete before trying to do anything else.
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2.3 Uninstalling PageScope Network Setup

2.3.1 For Windows 95/98/Me/NT/2000

1. Click Start — Settings — Control Panel.

2. Double-click the Add/Remove Programs icon.

3. On the Add/Remove Programs Properties dialog box, select
KONICA MINOLTA PageScope Network Setup in the list of
programs, and then click the Add/Remove button.

In the case of Windows 2000, click Change or Remove
Programs, click KONICA MINOLTA PageScope Network
Setup, and then click the Change/Remove button.

4. Follow the instructions that appear on the screen to complete the

uninstall procedure.

2.3.2 For Windows XP

1. Click Start — Control Panel.

2. Double-click the Add or Remove Programs icon.

3. On the Add or Remove Programs dialog box, select KONICA
MINOLTA PageScope Network Setup in the list of programs,
and then click the Change/Remove button.

4. Follow the instructions that appear on the screen to complete the
uninstall procedure.
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3 Browsing Network Devices

This section explains the contents of PageScope Network Setup
screens.

3.1 Screen Configuration

| (£ agescope retworksews -0/ x|
File() Setup(3) View(¥) HelpiH) I @
2 |] Jhp:/7192.168.0.23 I [IEEa 1IE= C
pr— & KONICA MINOLTA @ Ready
Urkniowr " . gi Ready
Urkroun 12 8258 Web Connection | —
Unknown System Job File Print Scan
Urkniown
Urknown » Summary )
magicalor 2200 Dl Device Status
Unknown Detail Copier Memory
L5 kMB_1A7CES
15 krB_247863 Meter Count Hard Disk
e
i Ouline Assistance Hetworl
@_ 15 ke _sooons basaki Duplex
Tl
I g Administrator’s Code : Input Teay —®
5 kie_so1477 L Output Tray
15 kie_7o00es ﬂl Document Handler
[EKME:?IZEAC Scanner
L5 kiB_718763
L5 KkrB_cooz29s
L5 kmB_Donase
- 1 sl 4] Il » |
@—_ Done 21 devices Found 4

@® Menu bar
Clicking on a menu pulls it down so you can access its commands.

@ Toolbar (for the device list)
The toolbar provides one-click access to often-used PageScope
Network Setup operations.

If you cannot see the toolbar on the display, select Toolbars on the
View menu.

... Displays the properties of the device selected in the device list.

@ ...Displays a dialog box for changing the settings of the device
selected in the device list.

& ... Displays alert information for the device selected in the device
list.
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Z] ... Displays output tray information for the device selected in the
device list.

<l ... Quits PageScope Network Setup.
£8 ...Refreshes the device list.

® Device list

..Displays on-line help.

This list show devices detected on the network.

To change the width of the device list, drag the border between the

device list and browser display area.

| PageScope Network Setup =

Fie(E) Setup(s) Wiew(y) Help(H)

=loix|

B @ A=l e®

|] [Pt 192.168.0.23

— |+ > HC

L5 kme.

Done:

| pevice Hame: | 1P Address | pevice Model Name. -
Unknawn 192.168.0.122 magicalor 2200 & KONICAMINOLTA
Unknawn 192.168.0.107 magicalor 2200 " .
Urknown 192.168.0.52 magicolor 2200 735 Web Connection
Unknown 192.168.0.74 magicolor 2200
Unknown 192.168.0.12 magicolor 2200
Unknown 192.168.0.212 magicolor 200 Summary
magicolor 2200 DL 192.168.0.65 magicolor 200
3 Unknewn 192.188.0 24 magicalor 2200 Detail
_1A7CES 192.168.0.87 magicolor Z350
6 kMB_247863 192.168.0.85 CF3102 Meter Count
(L 5lkme_s00024 FR4100GN 192.168.0.157 FagePra +100GN a 3
U5 kMg _S00002 192,168,038 CFalz G fehEmee
L5 KMB_S00006 basaki 192.165.0.202 CFa102
L5 kriB_S00049 192.168.0.25 CF310Z | dministrator's Code :
L5 kB _S005D2 192.168.0.46 cFanz
LS krip_S01477 192.163.0.236 CF3102 — Logrin
L5 iavB_7000E8 192.168.0.22 magicolor 2300 DL
L5 kMB_7128AC 192.168.0.213 magicolor 2300 DL
U5 kMB_718763 192.168.0.78 magicolor 2300 DL
5 kMe_conzge 192.162.0.86 magicolor 7300
5 KME_DanASE 192.165.0.197 Digsio

-

=

— 2l devicesfound 2
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Device
This is the device icon and device name. The icon that appears
differs according to the protocol used for connecting the device.

UE ...Device connected using TCP/IP

I8 ...Device connected using IPX

Devices connected using both TCP/IP and IPX will be displayed
with the TCP/IP icon.

The background color of the icon indicates the device status.
No color: Ready
Green:  Printing
Yellow: Alert
Red: Error

The device status is updated every 30 seconds (default setting).
The interval can be changed with the polling settings.

See 5.4 Specifying Polling Settings for details on changing the
polling interval.

Device Name
This is the device name for management purposes. If asterisks (*)
appear in the device name, non-ASCII characters have been used
for naming the device. In this case, we recommend that the device
name be changed as described in 4.1 Configuring Device
Information.

IP Address
This is the IP address allocated to the device.

Device Model Name
This is the device model name.

* Select Device Search from the File menu to perform a new device
search and display the latest network information on the device list.

* See 5 Option Setup for details about configuring the device
search operation.
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@ Status bar
When you move the mouse pointer to a toolbar button, the status bar
displays an explanation of the button’s function.

If you cannot see the status bar on the display, select Statusbars on
the View menu.

® Browser display area
This area displays the built-in Web setup page for the device
selected in the device list.

® Toolbar (for the browser display area)
The toolbar contains buttons for performing various operations in
the browser display area.

=
= ...

X ..
gl ..
3

Returns to the previously displayed page.

Advances to the next page after the pages have been scrolled
through using the <= button.

Closes the Web setup page display.
Refreshes the contents of the Web setup page.

Displays the current Web setup page in the standard Web
browser installed on your system.

@ URL field
This field displays the URL of the device selected in the device list.
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3.2 Verifying Device Setup Status

Verify the current device setup status as follows.

1.

2.

On the device list, click on the icon for the device whose setup
status you want to verify.

Select Device Property on the File menu.

You could also click the toolbar button.

This displays the Properties dialog which shows the current setup
status for the device.

Current setting for current device

t:| Device properties
=) G General
-l Device Madel Mame : GF1501/2001
(@ Device Mame : GF1601
@] Device Description : Shared MFP
B NetWare Printing
-8 Print Server Name : FIERYX3E
O] Ethernet Frame Type : Auto-Sense
-4 Queue Scan Rate : 20
Bindery Server : ENWS32E
~PE NDS Gontext : NGR
## NDS Tree : NGR_TREE
iy Service Queue : TESTG
€ Motified User : (PRINT JOE QUWNER)
=4 TGF/TP
=] DHGP : Disable
-] 1P Address : 192168.0.223
o] Subnet Mask : 265 266.255.0
-|E3 Default Gateway: 192168.0.1
@, Raw Port : 9100

* Click a [#| button on the tree to expand an item.

* Click a [=] button on the tree to collapse an item.

The Properties dialog contains the following information.
General

Displays the settings for managing the device. See 4.1 Configuring
Device Information for details about changing this setup.

NetWare Printing
Displays the setup for device NetWare printing. See 4.3
NetWare Print Setup for details about changing this setup.
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TCP/IP
Displays the setup for device TCP/IP. See 4.2 Configuring TCP/
IP for details about changing this setup.
3. After you are finished, click the OK button to close the dialog box.

Note

*  You cannot verify the following attributes unless you have NetWare
Client 32 installed on your system and log in to the NetWare server.
- NetWare Service Queue
- NetWare Notify User

3.3 Displaying the Device Alert Property

Follow the procedure described below to display the alert information
for the device selected in the device list.

x|
AlertH | Severity | Diescription | Code | Perzon to Contact | Time
1 Warning Faper Empty Trayl Input Media Supply Empty  Untrained Sunbap13
2 Warning Paper Mear Empty LCC Input Media Supply Low Untrained Sunbap13
| | i

1. In the device list, click the icon of the device whose alert
information you want to display.

2. Select Device Alert Property on the File menu. You could also
click the toolbar /& button.
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3.4 Displaying Device Output Tray Information

Follow the procedure described below to display output tray
information for the device selected in the device list.

Output Tray Informatiol ﬂ

Clutput Tray Mame | Olutput Tray Type
Olutput Tray 1 Other
Output Tray 2 Other
4] ] ©

1. In the device list, click the icon of the device whose output tray
information you want to display.

2. Select Device Output Tray Information on the File menu. You
could also click the toolbar =l button.

10
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4 Changing the Device Setup

Use the Device Setup dialog to change a device setup.

The following are the settings that can be configured when changing a
device setup.

¢ Device Information
« TCP/IP
¢ NetWare Print

4.1 Configuring Device Information

Perform the following steps to configure device information.

1.  On the device list, click the icon of the device whose information
you want to configure.

2. Select Device Setup on the Setup menu to display the Device
Setup dialog box.
You could also click the toolbar @ button.

3. Click the General tab.

Devica Setup [MLT_101809]

General | TGP/IP | Netiare |

Device Infor mation

Device Model Name:
GF1501/2001

Device Name:

GF1501

Device Description:

Shared MFP

T Gancel Help

11
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5.

You can configure and view the following items on the General
tab.

Device Model Name
This is the device model name. You cannot change the device
model name here.

Device Name

This is the device management name. You can type up to 16
characters into the text box to input a new name. However, if the
existing device management name exceeds 16 characters, you
can type up to 255 characters for a new name.

Only ASCII characters can be typed in. If asterisks (*) appear in
the device name, non-ASCII characters have been used for
naming the device.

Device Description
This is a description of the device. You can type up to 16
characters into the text box to input a new description. However,
if an existing description of the device exceeds 16 characters,
you can type up to 255 characters for a new description.
Only ASCII characters can be typed in. If asterisks (*) appear in
the device description, non-ASCII characters have been used for
describing the device.

After you are finished making the settings you want, click the OK

button. This displays the device properties with the changed

settings in blue.

If the settings are correct, click the OK button.

The community name input dialog box appears only if the SNMP
community name has been changed to something other than the default
name. Type in the community name and then click OK.

12



4 Changing the Device Setup

4.2 Configuring TCP/IP

Perform the following steps to configure TCP/IP.

1.

2.

On the device list, click the icon of the device you want to
configure.

Select Device Setup on the Setup menu to display the Device
Setup dialog box.

You could also click the toolbar @ button.

Click the TCP/IP tab.

Device Setup [MLT_101809]

General TGP/TP |NatWara Printing |

IP Address Setup
Select the IP address setup method The allocated IP address. as well ag the
subnet mask and default gateway value, must also be entered when the IP address
iz entered manually.

£ Obtain an IP address automatically
I uhGE | =iy

* Specify an IP address manually
1P Address: W W IU— W
Subnet Mask: Iﬁ lﬁ lﬁ IEI—
Default Gateway: Iﬁ W IEI— |1—
~Raw Port Number

Specify a port number for peer to peer printing.

IQT oo

QK I Gancel | Help |

You can configure the following items on the TCP/IP tab.

IP Address Setup

* Obtain an IP address automatically
If this option is selected, the IP address is acquired from either
the DHCP server or the BOOTP server.

- DHCP Select to obtain the IP address from the
DHCEP server.
- BOOTP Select to obtain the IP address from the

BOOTP server.

13



4 Changing the Device Setup

* Specify an IP address manually
When this option is selected, you can set the IP address
manually. Enter the following values.
- IP Address Device IP address
- Subnet Mask Subnet mask used with the network
- Default Gateway Default IP router address for the device

Raw Port Number

Enter the Raw port number used for peer-to-peer printing.
After making the settings you want, click the OK button. This
displays the device properties with the changed settings in blue.
If the settings are correct, click the OK button.
A message asking for confirmation to continue the setup appears.

NOTICE [

After changed network. setting, you may have to change
wour printer getting on wour computer, too.
Are you sure you want to continue this setup?

Click the Yes button.
A message stating that it is necessary to reset may appear.
For equipment that can be reset, the following dialog appears.

NOTICE

These changes will take effect after you restart the NIC,
Do pou want to reset it now or later?

Beset Maw | |

If there are no problems with resetting now, click the Reset Now
button.

Note

The community name input dialog box appears only if the SNMP
community name has been changed to something other than the default
name. Type in the community name and then click OK.

If both DHCP and BOOTP are selected, DHCP is given priority.

14
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4.3 NetWare Print Setup
Note

You must have NetWare Client 32 installed on your system in order to
setup for NetWare printing.

NetWare supervisor privileges are required in order to change the
NetWare Print Setup. You must login to the NetWare network with
supervisor privileges in order to configure NetWare for printing.

You must have IPX protocol installed on your device in order to
configure a NetWare print setup.

If you have already configured a NetWare print setup with another tool,
the existing configuration will be deleted when you complete this setting.

Perform the following steps to configure a device for NetWare printing.
1.

2.

(9%

On the device list, click the icon of the device you want to

configure.

Select Device Setup on the Setup menu to display the Device

Setup dialog box.

You could also click the toolbar i@ button.

Click the NetWare Printing tab.

Perform the following steps.

* Set up the print server. See 4.3.1 Setting up the Print Server.

» Select the mode. See 4.3.2 Selecting the Mode.

* Set up the print queue. See 4.3.3 Selecting the Print Queue.

 Select users for event notification. See 4.3.4 Selecting Users for
Event Notification.

* Verify the setup. See 4.3.5 Verifying the Setup.

Note

Clicking the NetWare Printing tab downloads the device
configuration. Downloading can take anywhere from a few seconds to
20 or 30 seconds or more. Wait for the download procedure to
complete before trying to do anything else.

The community name input dialog box appears only if the SNMP
community name has been changed to something other than the default
name. Type in the community name and then click OK.

15
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4.3.1 Setting up the Print Server

Standard | TOP/IP Netihare |

For using MetWare printing, setup the configuration of print server and queue to
adevice and the connection with NetWare server. Moreover, setup the user
who receives a notice of the event which happened on this device.

In addition, please input a print server name and other settings

Print Server Name FIERYXIE
Print Queue Scan Rate 20

Ethernet Frame Type
I lfuta-Sense. 7| Ethernet T I= 8022

= [ B0zs J= | B2 S H AR

R e | Setpin|
o | Gancel | Help |

Perform the following steps to set up the print server for NetWare
printing.

1.

Type up to 26 characters into the Print Server Name box for the
print server name.

Only ASCII characters can be typed in. If asterisks (*) appear in
the print server name, non-ASCII characters have been used for
naming the print server.

Normally, you should leave the following items set to their initial
defaults. Change these settings only when absolutely necessary for
some reason.

Print Queue Scan Rate
Type in the interval, in seconds, to specify how often the print
server should check the queue.

Ethernet Frame Type
Specify the Ethernet frame type.

16



4 Changing the Device Setup

2. After you are finished configuring the setup, click the Next button.
Note

» To configure a NetWare print setup, the server must be bound to at least
one IPX frame.

4.3.2 Selecting the Mode

Use the procedures in this section to select the server you want to
configure as the print server, or the NDS context.

Device Setup [MLT 101

Standard | TOR/IP  Netibiare |

Specifies a connection server S context in hete
Click the icon of each mode after selecting the mode and select Sub-tree used
from the list of objects.

¥ NetWare 3.x Bindery Server

[enwsaze =

¥ NetWared x NDS Gontext

[MGR_TREE |

b o
[har = El

< Back | [ Mext>r | |

s Gancel | Hele |

If you are using bindery service (NetWare 3.x):

1. Put a check mark into the NetWare 3.x Bindery Server check
box.

2. Click the [E] button to display the Mode Select dialog box, which
shows a list of servers on the NetWare network.

3. Select the server you want to configure as the print server, and then
click the OK button.

4.  When everything is the way you want, click the Next button.

17



4 Changing the Device Setup

If you are using NDS (NetWare 4.x or 5.x):

1. Puta check mark into the NetWare 4.x NDS Context check box.

2. Click the #¥ button to display the Mode Select dialog box, which
shows a list of NDS trees on the NetWare network.

3. Select the NDS tree you want to setup as the print server, and then
click the OK button.

4. Click the P§ button to display the Mode Select dialog box, which
shows a list of NDS contexts for the tree you selected.

5. Select the NDS context to setup the print server, and then click the
OK button.

6. When everything is the way you want, click the Next button.

Note

* If you are logged on to the NetWare network without supervisor
privileges, the NetWare login screen will appear after you finish
configuring the setup. If this happens, type in the supervisor login
name and password, and then click OK.

18
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4.3.3 Selecting the Print Queue

Use one of the following procedures to select the print queue for the
print job.

Device Setup [MLT_101809]
Standard | TOR/IP Netibiare |

Select the queue to uze, and click on [Append].

NGR 'l
Servers FIERYXIE

"==*| LJ5K ey TESTG . NGR

i TESTEN

Append> >
<< Delete
Create new
T e | T |
(ks Gancel Help |

To select an existing print queue:

1. Use the upper left box to select an NDS tree (in the case of NDS)
or a server (in the case of bindery service). This displays a list of
print queues for the selected NDS context (in the case of NDS) or
server (in the case of bindery service) in the list on the left.

2. In the list on the left, select the print queue you want to use, and
then click the Append button to add the print queue to the list on
the right.

3. Toremove a print queue from the list on the right, select it and
then click the Delete button.

4. When everything is the way you want, click the Next button.

19



4 Changing the Device Setup

To create a new print queue:

1.

2.

Use the upper left box to select an NDS tree (in the case of NDS)
or a server (in the case of bindery service).

Click the Create New button to display the Add Queue dialog
box.

Add Clueue Dialog E

MName

olume
|nar SERVER HOMENGR =]

Gontext

[NGR

Cancel |

Type up to 26 characters for the name you want to assign to the
new print queue into the Name box.

Use the Volume list to select a volume for the new print queue.
Note that you cannot change the volume for creating the new print
queue when using bindery service.

When using NDS only, type the NDS context name into the
Context box. Note that you cannot input a NDS context name
when using bindery service.

When everything is the way you want, click the OK button.

20



4 Changing the Device Setup

4.3.4 Selecting Users for Event Notification

Standard | TOR/IP Netibiare |

Select the user who receives a notice of the event which happened on this device
from the list of servers.

¥ Motity owner of print job

FIERYX3E
- ff§ (PRINT JOB OWNER)

- SUPERVISOR

- GUEST Append>>

<< Delete

Back | [ Mestr | setp |

G| Gancel | Hele |

Perform the following steps to select users for notification of events
occurring on the device.

1.

Use the upper left box to select an NDS tree (in the case of NDS)
or a server (in the case of bindery service). This displays a list of
users for the selected NDS context (in the case of NDS) or server
(in the case of bindery service) in the list on the left.

In the list on the left, select a user to be notified and then click the
Append button to add the user to the list on the right.

To remove a user from the list on the right, select it and then click
the Delete button.

To notify the user who originated the print job of an event, put a
check mark into the box next to Notify owner of print job. Doing
so causes the PRINT JOB OWNER icon to appear in the list on the
right.

When everything is the way you want, click the Next button.

21
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4.3.5 Verifying the Setup

tup [MLT

Standard | TOR/IP Netibiare |

GCheck MetWare setup

rﬂ' MetWare Setup

- i# Print Server Name :FIERYX3E
?ﬂ Ethernet Frame Type :Auto-Senge
Queue Scan Rate :20

Bindery Server :EMWS3I2E
~M8 MDS Gontext :MGR

& NDS Tree :NGR.TREE
Service CQueue :

iy TESTQT.NGR

Matified User

- (PRINT JOB OWNER)

<< Back |

| Gancel |

The NetWare setup details are displayed in the list.

* Click a [#] button on the tree to expand an item.

* Click a [=] button on the tree to collapse an item.

If you want to change something in the setup, click the Back button to
return to the setup screen, and then make the changes you want.

If the setup is the way you want, click the Setup button to proceed with

the setup.

A message asking for confirmation to continue the setup appears. Click

the Yes button.

NOTICE =]

After changed netwark setting, you may have to change
your printer setling on your computer, too.
Are you sure pou want o continue this setup?
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A message stating that it is necessary to reset may appear.

If there are no problems with resetting now, click the Reset Now
button.

NOTICE

These changes will take effect after you restart the NIC,
Do pou want to reset it now or later?

BReset Mow

23



5 Option Setup

5 Option Setup

Use the Option dialog box to configure PageScope Network Setup
options.

The following are the settings that can be configured when changing
the option setup.

* Protocol (See 5.1 Selecting a Protocol)

» Search Range (See 5.2 Specifying the Search Range)
BOOTP Setting (See 5.3 Specifying BOOTP)
Polling Setting (See 5.4 Specifying Polling Settings)

Password Setting (See 5.5 Changing the Password)

5.1 Selecting a Protocol

Perform the steps below to select the protocol for use with PageScope
Network Setup. The functions available with PageScope Network
Setup depend on the protocol that is currently selected.

1. Select Option on the Setup menu to display the Option dialog box.
2. Click the Select Protocol tab.

: K|
[ Sefect Prctocal | Speciy Search Rangs | BODTP Setting | Poling Setting | Passward Seting |

~ Select Pr

Salect the protacol for use with this toal. The protosal matching the setup
envirarment for the current local machine is selected by default

When making changes, ensure that at least ane of the protacals is selected

¥ IF Protocal

¥ IP Protocol

Retun to standard setting

Cancel Help
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5 Option Setup

3. Putacheck mark into the box next to option you want to use under
Select Protocol. You must select at least one protocol, however

both can be selected.
Click the Return to standard setting button to return to the

protocol to the standard default.

4. Click the OK button.
5. On the confirmation dialog box that appears, click the OK button.

5.2 Specifying the Search Range

When using IP protocol, perform the steps below to specify the
network device search range. Note that you cannot specify the search

range when using IPX protocol.
1. Select Option on the Setup menu to display the Option dialog box.

2. Click the Specify Search Range tab.

x|

Select Protacel | Speciy Seaich Range| BOOTP Setting | Poling Setiing | Password Setting |

Specify the devios discavery range (IF orly)
I IPX Discavery
I¥ IF Discavery
~Specify IP discovery range —Add devics manualy

Although most devices are discovered
automatically by the "Devics Search”
function, you may need to add ather
devices manually

Specily the IP addiess and subnet mask
for the device, These search range is
determined automaticall.

IPAddress: [192 [168 [ 0 [143
Subret Mask: [355 [2%5 [258 [ 0 Peddess[ [ [ [

Discover Range Add Device
Fwszws 0. 1192 169. 0.254
Append | Dielete Append | Dielete
xen_| o |

3. A check mark is in the box next to the protocol that is currently
selected on the Select Protocol tab. See 5.1 Selecting a Protocol
for details about changing the protocol setting.
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5 Option Setup

Specify IP discovery range:

Perform the steps below to specify the IP address range for the network
where the device is searched for. PageScope Network Setup searches
for devices on the broadcast address of the network specified here.

a.

b.

Type the IP address of the device you want to find into the IP
Address box.

Type the subnet mask used by the network into the Subnet Mask
box.

Click the Append button.

The search range is set automatically in accordance with the
values you entered in the previous steps, and the resulting search
range appears in the Discovery Range box.

Add device manually:

A device that cannot be automatically searched for can be displayed in
the device list by entering its IP address.

a.

b.

Type the IP address of the device you want to display into the IP
Address box.

Click the Append button.

If the entered IP address is accessed and there is a response, that [P
address is added to the Add Device box.

To remove an address appearing in the Add Device box, select it,
and then click the Delete button.

If everything is the way you want, click the OK button.
On the confirmation dialog box that appears, click the OK button.
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5 Option Setup

5.3 Specifying BOOTP

Perform the following steps to specify the settings for operation as a

BOOQOTP server.

1. Select Option on the Setup menu to display the Option dialog
box.

2. Click the BOOTP Setting tab.

Option = x|

Select Pratocol | Specify Search Range  BOOTP Setting | Poling Setting | Password Setting |

“You can use the BOOTP protocol for assigning IP address to device. After finishing
the settings below, you must restart your dewice.

~BOOTP Server Setting
Specify IP address, and click [Append] button
Clignt List
@ Wsperers:
el e L
ppen i
o e
" Individually ﬂl b
Soae 52 [ [ 7 [ ©
Configure
Cancel I Help |

3. To operate as a BOOTP server, put a check mark beside Enable
BOOTP Server, and then specify the following BOOTP server
settings.

To specify an IP address range for assigning the BOOTP server:

1. Select the Using a range option.

2. Enter IP addresses into the Start and End boxes, and then click the
Append button.
The specified IP addresses are added to the Client List box.

To specify a single IP address for assigning the BOOTP server:
1. Select the Individually option.
2. Enter an IP address into the Single box, and then click the
Append button.
The specified IP address is added to the Client List box.
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5 Option Setup

To assign a particular hardware address to an IP address in the
Client List box:
1.  From the Client List box, select the IP address that will be
assigned the hardware address.
2. Click the Configure button.
A dialog box for setting the hardware address appears.

BOOTP Client Configure E3

“f'ou can specify the relation between IP address and
hardware address. If you specify branks on [Hardware
Address], the IP address will be reused for other

BOOTP client.
IP &ddress : Iﬁ lﬁ l—DI—Z

Hardware Address : W lﬁ lﬁlﬁ IE m
] concel |

(9

Enter the hardware address into the Hardware Address box.

4. Click the OK button.

The setting appears in the Client List box.

To remove the setting for the IP address with a hardware address
assigned, delete any values entered into the Hardware Address
box, and then click the OK button.

After specifying the BOOTP settings, click the OK button.
Note

* After sending the IP addresses to a device, the L§ icon is displayed in
the Client List box. This mark means that the address was assigned
while the PageScope Network Setup is working.
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5 Option Setup

5.4 Specifying Polling Settings

The function for monitoring the device status can be turned on or off,
and the interval for polling the devices can be specified.

Option a x|

Select Protocal | Specify Search Range | BODTP Setting  Poling Setting | Password Setting |

- Paling

* Enable " Disable

~ Palling Interval

30 FRange : 10 - 600

Cancel | Hep |

* Polling To monitor the device status, select Enable.

To quit monitoring the devices, select
Disable.

* Polling Interval Type in the interval, in seconds, to specify
how often the devices should be polled.
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5 Option Setup

5.5 Changing the Password

The password used to start up PageScope Network Setup can be

changed.
Dption x|
Select Protocal | Specity Search Rangs | BODTP Seting | Paling Setting PﬂSSWDfﬂSE“‘"Ql

Passward :

New Passward :

Retype New Password

Cancel | Hep |

1. Type in the current password into the Password box.
2. Type the new password (maximum 16 characters)

Password box.

into the New

3. Retype the new password into the Retype New Password box.
4. Click the OK button.
Note

* The default password is “admin”.

30




Appendix Glossary

Appendix Glossary

Bindery service

A system used to manage network user information in a database for
each server. Mainly, used with NetWare 3.x and earlier.

BOOTP
A protocol used to automatically allocate TCP/IP parameters (eg. IP
address) to the client on the TCP/IP network from the server.

DHCP

A protocol used to dynamically allocate IP addresses to the host.

Frame type

Packet data format used with Ethernet.

Hardware address

A unique hardware address assigned to the network interface of the
device connected to an Ethernet.

Host name

A character string representing the name of the host, which is allocated
to the IP address.

IP address

An address identifying the host at the data source and destination with
an IP connection.

IPX address

An address identifying the data source and destination nodes with the
IPX connection.
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Appendix Glossary

NDS

A system for managing all network resources in a hierarchical database
at a single point. Mainly, used with NetWare 4.x and later.

Port number

A number used to identify application programs at the data source and
destination with the IP connection.

Raw port number

The number of the port at which the device receives data when print
data is sent directly to the device.

Subnet mask

A mask value used to delineate between the IP address network and
host addresses.
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